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SHUTTER CLOSED 

February 6th - Meeting at Parker College.  
CONTEST - We will view results of January turn-in, 
“Openy”. Turn in “Bad Weather” prints, slides and digital 
files. 
 
February 20th – Frank Richards from the Dallas camera 
club will talk about color and photography. 
 
March 6th – We will view results of February turn-in, 
“Bad Weather”. Turn in “End of Year” prints, slides and 
digital files. 
The four categories for the End of Year turn-in are: 
Milton J. Rudick Travel Award—up tp 4 digital entries 
per member.  Any image taken outside of the DFW 
Metroplex within the last 12 months qualifies. 
Ken Zapp Field Trip Award—up to 4 digital entries per 
member.  Images taken on any of the DCC field trips 
scheduled this year qualify. 
Marge Dance Contemporary Image—up to four digital 
images per member. 
J.J. Spurlock Creative portraiture—up to four prints per 
member. 
 
March 20th – Peter Poilides will talk about and give 
some examples of digital time lapse photography. 

Guests  
Elaine Becker 
Jerry Davis 
Travis Max 

New Members  
 

Michael McAleer  

January 2nd - Members turned in their January entries 
in the “Open” category.  The Images from “Around the 
Doorway” competition from December where shown.   
Many in attendance were disappointed with the judging.  
Apparently, both the print judge and, to a lesser degree, 
the digital image judge, did not interpret the category as 
it was explained to the members.  Mant members     
received low scores of 7 or 8 because the judge felt 
their image did not fit the category.. 
  
January 16th -  All members were encouraged to sub-
mit entries for the four categories of Special Awards that 
will be turned in at the first March meeting, judged and 
viewed at the April awards banquet. 
The program on photographing hummingbirds pre-
sented by Sid Rucker was cancelled because Sid could 
not get to Dallas due to icy weather.  Instead a program 
put on by Jerry Comer, David Gregory, Bob Sherman, 
Frank Richards, and Paula Buzenius discussing and 
showing examples of Photoshop plugins, Photoshop 
techniques, and digital image presentation software.  
The two plugin discussed was noise reduction software 
from www.neatimage.com and a B/W conversion plug-in 
from www.powerretouche.com.  David also talked a little 
about Pro Show Gold from www.Photodex.com.  This 
software allows the user to put images, transitions, mu-
sic and text together to make a slide show.  Bob dis-
cussed the B/W conversion software and also men-
tioned other avenues of information available to photog-
raphers through the NAPP (National Assoc. of Photo-
shop Professionals), beta version CS3, and Layers 
magazine.  Jerry presented some information on a 
budget ink cartridge web site and on the web site were 
members can get some glossy white film for printing 
extremely glossy prints.  Paula demonstrated how to 
convert an image from color to B/W and how to sharpen 
an image. 

SHUTTER OPEN 
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HOSPITALITY 
 
Please consider making a 25-50 cent donation into the hospi-
tality donation cans when you partake of the refreshments 
brought to each meeting. This money is used to buy the paper 
plates, napkins, ice and cups. If you know you will not be at 
the meeting when you are scheduled for hospitality, please 
find someone to take your place and let Linda Clifford know as 
well. Those members whose names appear each month in the 
space above are asked to bring drinks and/or snacks to the 
meeting that they are listed by. 

February 6 Suzanne Graham 
David Gregory 
Kay Hale 

February 20 Kaye Hargis 
Frank Hedges 
Amy Hogge 

March 6 Kate Jones 
Gary Kelly 
PD Killion 

March 20 Bob  Krause 
David Linton 
Tom Marusa 

THRU THE LENS  DALLAS CAMERA CLUB 

HOSPITALITY SCHEDULE by The Editor   �DALLAS CAMERA CLUB FIELD TRIPS �
 
March -Tour of Churches in Fort Worth 
 

 

 
 
 

 Important Field trip Information: 
Images are needed for the Bosque del Apache field 
trip.  Please get your images to Philip Johnson or Gary 
Kelly.  Images are needed within the next two weeks. 

COMPETITION SCHEDULE FOR 
2006-2007YEAR 
May 2nd - Open 

June 6th - House hold Items 
July 11th - Open 

August 1st - Flight 
September 5th - Open 

October 3rd - Bag of Pics 
November 7th - Open 

December 5th - Around the Doorway 
January 2nd - Open 

February 6th - Bad Weather 
March 6th - End of Year Images 

Photoshop Tip of the Month  
 

Neutralize Your Image 
Creating a neutral reference for the Set Gray Point 
Levels or Curves can take a lot of the guesswork out 
of neutralizing an image.  Duplicate the image and use 
Filter>Blur>Average.  Return to your original image 
and add a Levels (or Curves) adjustment layer
(Layer>New Adjustment Layer>Levels or Curves).  
Use the Set Gray Point eyedropper and click on the 
duplicated/averaged file to neutralize stubborn color 
cast. 
(this tip came from the December issue of Photoshop 
User) 
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December 2006 Print WINNERS - ”Around the Doorway” 

Robert Sherman, Tuscola Warriors, Advanced Prints, 1st Place 

Ann Redfearn, Doorway Arches,                         
Advanced Prints, 2nd Place 

Kevin Moody, Last Flicker of Fire, Advanced Prints,        
3rd Place 

John Wathne , Winter Heat, Beginner Monochrome, 
1st Place 

Ann Redfearn, Outside the Door, 
Beginner Monochrome, 2nd Place 
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Eleanore Avery, Church Door,      
Masters, 2nd Place 

Puala Alcorn, Old Door Front, 
Beginner Monochrome,                  
3rd Place 

Paula Alcorn, Old Door, Beginner, 1st Place 

Mel Sharp,     
Shoes Off Before 
Entering, Masters, 
1st Place 

December 2006 Print WINNERS (continued) - ”Around t he Doorway” 
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Nelosn Spencer, Papas Mailbox, 
Beginner, 2nd Place 

Mel Sharp,  Air Conditioners,  
Monochrome Advanced, 1st Place 

December 2006 Print WINNERS (continued)- ”Around th e Doorway” 

Daylon Walton, Beauty in 
Belize, Beginner, 3rd Place 

Robert Sherman, Abandoned, Monochrome   Ad-
vanced/Master, 2nd Place 

Tom Marusa, Doorway to Courtyard, 
Monochrome Advanced, 3rd Place 
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December 2006 Projected Image WINNERS - ”Around the  Doorway” 

Todd Hampton, Puking Pumpkin, Beginner PIC,        
1st Place 

Paula Alcorn, Caught in the Door,           
Beginner PIC, 2ndPlace 

Suzanne Graham, Nothing 
Much,  Beginner PIC,   
3rd Place Kevin Moody, Neglected, Advanced PIC, 1st Place 
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December 2006 Projected Image WINNERS (continued) -  ”Around the Doorway” 

Harry Rumberger, Worn Path to 
Moorish Door, Advanced PIC,        
2nd Place 

Eleanore Avery, Monolian Ger in Morning, Masters  PIC, 3rd Place 

David Gregory, Las Trampas Church 
Door, Advanced PIC,  3rd Place 

Eleanore Avery, Houses Up the Hill, Masters PIC, 1st Place 
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Master Images May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Total 

 Eleanore Avery 14 15 11 12 12 14 12 14 12 14 8 10 9 12 13 15     197 
 Jerry Comer 10 11 10 15 12 13 10 11 12 15 14 12 14 15 9 12     195 
 Tom Marusa 10 10 10 14 12 14 12 12 10 13 10 15 9 11 8 10     180 
 Paula Buzenius 9 10 13 14 10 12 13 15 9 11 11 11 9 9 8 11     175 
 Gary Kelly 9 10 11 14 12 15 12 13 10 10 8 9 10 10 8 10     171 
 Sharon Dorsey 9 9 11 13 11 12 11 13 9 11 9 13   10 14     155 
 Kaye Hargis 10 11 8 12 11 13 12 13 9 11 9 11 8 12       150 
Dody Bracken     11 12 10 11 9 12 8 9 9 13 9 10     123 
 Nellie Bretherick 11 13 10 12 12 13 13 14 9 12           119 

Advanced Images May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Total 

 Bob Sherman 12 14 10 13 10 12 11 12 10 11 11 12 12 13 10 11     184 
 Harry Rumberger 9 11 8 10 9 12 9 14 12 13 10 14 11 12 12 14     180 
 LeDon Becker 9 10 9 12 11 14 9 13 12 15 10 10 10 10 10 11     175 
 Frank Richards 10 11 8 15 12 13 9 13 9 10 8 15 12 13 6 8     172 
 Mel Sharp 10 13 9 9 9 10 11 11 8 9 8 13 10 15 11 11     167 
 Kevin Moody 10 12   10 12 11 15 13 14   11 12 9 15     144 
 Ann Redfearn 11 11 8 9 11 14   8 8 8 8 10 12 12 12     142 
 David Gregory 9 9   10 13 9 9 9 9 8 9 12 12 10 13     141 
 Frank Hedges 10 12 8 11 8 10 10 12 8 9   11 13 8 8     138 
 Bruce Faust 9 10 9 14 13 15 12 14     12 12 11      131 
 Jessica Gluck 9 15 9 10 12 12 8 12 10 12           109 
 Sarker Swapan   9 9   11 12 10 12   7 11 9 9     99 

 John Wathne     9    11 8 8 10 11   8 9 9 10     93 

 Raymond Shay 10 13 8          10 13       54 

Beginners Images May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Total 

 Todd Hampton     9 13 9 11 9 15 12 13 10 14 14 15 8 15     167 
 Paula Alcorn 11 15 10  12 15 9 9 9 9 13  11   14     137 
 David Linton 9 13 12 15 9 10 9 10     9 10       106 
 Bob Krause 9 10   11 13   11 15 15  9 9       102 
 Suzanne Graham       12 13   8 10 7 8  13     71 
 George Buxbaum         10 14   12 13       49 
 Steve Newman       8 10     9 13       40 
 Spike Eskins     8        9 10       27 
 Aruna Birakayala     10 13               23 
 Philip Johnson 10 11                   21 
 Steve Quam     10  11              21 
 A. H.               8 9     17 
 Gordoen Goldstien               8 9     17 

YEAR TO DATE SCORES – PROJECTED IMAGES 
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Master Color 
Prints 

May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Mar. Apr. Total 

 Eleanore Avery 12 10 15 11 12 15 13 14     102 

 Mel Sharp 12 14 13 14 12 10 12 15     102 

 Jerry Comer 15 12 14 15 14 11 13 7     101 

 Gary Kelly 14 15 14 12 13 13 12 7     101 

 Paula Buzenius 13 13 14 10 14 11 14 7     96 

 Dody Bracken 13 13 14 8 12 12 10 7     89 
 Kaye Hargis 12 9  9 15 11 15      71 
 Nellie Bretherick 14 11 14 13 12        64 

Advanced Color 
Prints 

May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Mar. Apr. Total 

 Robert Sherman 15 15 14 15 13 15 14 15     116 
 Frank Richards 13 14 15 9 15 13 14 7     100 
 Ann Redfearn 11 10 12 14 9 13 11 14     94 

 Tom Marusa 12 8 13 10 14 12 12 7     88 

 David Gregory 11  14 11 9 10 13 12     80 
 Kevin Moody 12  12 14 12  15 13     78 
 Dave Rochier 13 8 12 8 9  12 12     74 
 John Wathne 11  12 12 12  13 12     72 
 Harry Rumberger 11 13 12 11   11      58 
 Bruce Faust 13  14 10   14      51 
 Jessica Gluck 11 12 14          37 
 Philip Johnson 14  14          28 

 Neil Curver 12            12 
Beginner Color 

Prints 
May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Mar. Apr. Total 

 Nelson Spencer  8 11 15 13  9 13     69 
 Paula Alcorn   14  11 14 9 15     63 
 David Linton 12  10 14   11      47 
 LeDon Becker 15  12    11      38 

 Bob Krause 13  15    9      37 

 Kate Jones  15   15        30 

 Gordon Goldstein      15 10      25 

 Aruna Birakalaya 14            14 
 Stephen Quam    10         10 
 Amy Hogge             8 
 Daylon Walton             8 

 George Buxbaum     10  15      25 

YEAR TO DATE SCORES - COLOR PRINTS 
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Advanced/
Masters       

Monochrome 
Prints 

May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Mar. Apr. Total 

 Frank Richards 11 15 15 13 13 13 12 13     105 

 Tom Marusa 15 10 12 10 15 11 11 13     97 

 Robert Sherman 14 8 13 15 13 11 9 13     96 

 Gary Kelly 11 13 14 9 11 11 15 7     91 

 Paula Buzenius 11 14 14 14 10 10 9 7     89 

 Jerry Comer 12 11 13 11 10 15 10 7     89 

 Eleanore Avery 13 8 12 12 14 10 10 7     86 

 David Gregory 12  14 8 13 12 10 10     79 

 Mel Sharp 11 8 13 8 10  10 15     75 

 Nellie Bretherick 12 10 13  14        49 

 Jessica Gluck 12 11 14          37 

 Philip Johnson 13  14          27 
 Bob Krause 12            12 

Beginner       
Monochrome 

Prints 
May  June  July  Aug.  Sept.  Oct.  Nov.  Dec.  Jan.  Feb.  Mar. Apr. Total 

 Ann Redfearn 12 8 12 5 15 15 12 4     83 

 Nelson Spencer  15 10 10 11  15 13     74 

 Harry Rumberger 15 13 11 12   11      62 

 John Wathne   11 15 9  9 15     59 

 Paula Alcorn   15  9   14     38 

 George Buxbaum     13        13 

 Spike Eskins 11  13    10      34 

 Bob Krause   10    10      20 

 David Linton 11  12 10         33 
 LaDon Becker   14    10      24 

 Aruna Birakayala 13            13 

 Suzanne Graham       9      9 

YEAR TO DATE SCORES - MONOCHROME PRINTS 
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DECEMBER 2006 WINNERS 
         

Projected Images - “Around the Doorway”  Prints - “Around the Doorway” 
Beginners  Beginners Color 

Name Title Score Place  Name Title Score Place 

 Todd Hampton  Puking Pumpkin 15 1   Paula Alcorn  Old Door 15 1 

 Paula Alcorn  Caught in the Door 14 2   Nelson Spencer  Papa’s Mailbox 13 2 

 Suzanne Graham  Nothing Much 13 3   Daylon Walton  Beauty in Belize 8 3 

         

         

         
Advanced  Advanced Color 

Name Title Score Place  Name Title Score Place 

 Kevin Moody  Neglected 15 1   Robert Sherman  Tuscola Warriors 15 1 

 Harry Rumberger  Worn Path to Moor-
ish Door 14 2   Ann Redfearn  Doorway Arches 14 2 

 David Gregory  Las Trampas 
Church Door 13 3   Kevin Moody  Last Flicker of Fire 13 3 

 Ann Redfearn  Reflection of an icy 
doorway 12 HM   John Wathne  Make an Entrance 12 HM 

 Ann Redfearn  Around the Door 12 HM      

 Harry Rumberger  Around 2 doors 12 HM      

         
Masters  Masters Color 

Name Title Score Place  Name Title Score Place 

 Eleanore Avery  Houses up the Hill 15 1   Mel Sharp  Shoes off before en-
tering 15 1 

 Sharon Dorsey  Waiting for Mail 14 2   Eleanore Avery  Church Door 14 2 

 Eleanore Avery  Mongolian Ger in 
Morning 13 3      

 Jerry Comer  Steps in Fall 12 HM      
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Prints - “Open”  

Name Title Score Place 

 John Wathne  Winter Heat 15 1 

 Ann Redfearn  Outside the Door 14 2 

 Paula Alcorn  Old Door Front 13 3 

    

    

    

Monochrome Beginners  

November 2006 WINNERS  

Prints - “Open”  

Name Title Score Place 
 Mel Sharp  Air Conditioners 15 1 

 Robert Sherman  Abandoned 13 2 

 Tom Marusa  Doorway to Courtyard 13 3 

 Frank Richards  Lizard 13 HM 

    

    

Monochrome Advanced/Masters  
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The Dallas Camera Club  
meets 1st and 3rd Tuesdays 

at the Parker Chiropractic College,  
2500 Walnut Hill Lane, South Building, Dallas, Texas. 
Directions: From I-35, turn east on Walnut Hill Lane. 

Turn right (south) on Ables, the second light, 
and go south for one block. 

Turn left on Electronic. Go about 1/2 block, 
turn left to enter the college through the south gate. 

Come in the main door, 
take the elevator to the 2nd floor. 

Go west to the end of the hall, turn left into Room 226. 
Refreshments and fellowship begin at 7:00 PM. 

Meeting begins at 7:30 PM.  
Visitors are always welcome. 

 
http://www.dallascameraclub.org 

Editor: Philip Johnson 
3422 Ivanhoe Lane 
Garland, TX  75044 
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Fi rs t  C lass  Mai l  

THRU THE LENS  DALLAS CAMERA CLUB 

President:                            Jerry Comer 

Past President:                    Paula Buzenius 
Vice President:                    Bob Sherman & Dave Gregory 

Secretary:                            Tom Marusa 
Treasurer:                            Adela Rochier 
Newsletter Editor:                Philip Johnson 

Projected Images:               David Linton & Ann Redfearn                             
Prints:                                  Neil Curver & Kevin Moody 

Field Trips:                          Gary Kelly 
Historian:                            Paula Buzenius 
Hospitality:                          Jim & Toni Broadwater 

House Managers:B             Bill Forbis & Dave Rochier 
Membership:                       Dody Bracken 

Web Site:                            Alex Bischoff & Swapan               
 Sarkar 
Yearbook:                           Harry Rumberger 
PSA Representative:          Dan Meredith 

GSCCC Representatives:  Barbara & Ralph Pyke 
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2006 - 2007 CLUB OFFICERS 

Go to: http://www.psa-photo.org 


